Resource Center
by Dan L. Swango, PhD, MAI, SRA

Inflation Outlook and
Statistical Analysis Software Resources
About This Column
Resource Center is about all types of information resources that may be helpful for real estate market analysts and
valuers—from print and online publications to data sources and websites. In this edition of Resource Center, we take
a look at the latest resources on the economic outlook, inflation, and the consumer price index. The column also
points researchers to the latest statistical software available online—both free and fee-based.

Economic Outlook
Many observers of the economy were surprised at
the health of the real estate sector of the economy
during the COVID-19 pandemic.1 But as we look
forward, concerns proliferate about issues such as
•	possible interest rate increases;2
•	shifting retail trends;3
•	property re-use alternatives;4
•	likelihood of higher or new taxes;

•	
changes in work location (office versus
remote);5
•	
population shifts and changing attitudes
about high-density urban living;6
•	changing warehouse, logistical, and industrial real estate needs;
•	polarization of economic and public policy
positions;
•	use of blockchain and cryptocurrencies; and
•	inflation outlook.

For easy, direct access to the URL addresses noted throughout this article, read this column online. Go to https://bit.ly/TAJ_Articles and click on
“Latest Issue.”
1. In the first half of 2020, common wisdom was that the pandemic would mean deferral of major spending decisions. However, reports
during the 2021 first quarter noted the opposite; see Soma Biswas and Harriett Torry, “Coronavirus Was Supposed to Drive Bankruptcies
Higher. The Opposite Happened,” Wall Street Journal, March 29, 2021, https://on.wsj.com/3wf9ewP; Nicole Friedman, “US Home Prices
Rise at Fastest Pace in 15 Years,” Wall Street Journal, March 30, 2021, https://on.wsj.com/3m515WO; Nicole Friedman, “The Pandemic
Ignited a Housing Boom—but It’s Different from the Last One,” Wall Street Journal, March 15, 2021, https://on.wsj.com/3rwW1vv; and
Peter Lan Taylor, “COVID-19 Set America’s Housing Market on Fire,” Forbes, March 11, 2021, https://bit.ly/2QRQWkZ.
2. For reference, the 15-year first mortgage interest rate has been under 4.5% for the past decade, which has stimulated commercial and residential real estate markets. During the prior decade, the rate declined from 8.25% to 4.25% (stated rates vary a little depending on source).
3. For discussion of e-commerce trends, see “A Decade in Review: Ecommerce Sales vs. Retail Sales 2007–2020,” Digital Commerce 360,
January 29, 2021, https://bit.ly/3cwff09; Michelle Evans, “Five E-Commerce Trends That Will Change Retail in 2021,” Forbes, January 12,
2021, https://bit.ly/39l1U8S; and Maryam Mohsin, “10 Ecommerce Trends,” Oberlo (blog), April 3, 2021, https://bit.ly/3fed1CW.
4. For example, see Beth Mattson-Teig, “Adapting CRE to Covid-19,” CIRE (Spring 2021), available at https://bit.ly/3fzO8Dx; and Byron Smith,
“Surviving Retail in Troubled Times,” CIRE (Spring 2021), at https://bit.ly/3dbVKsV.
5. “Remote Work Trends and Stats for 2021: The Present and Future of Remote Work after COVID,” Remoters (blog), https://bit.ly/3csoLBw;
Caroline Castrillon, “This Is the Future of Remote Work in 2021,” Forbes, December 27, 2020, https://bit.ly/2QMcqzH; and Brian Kropp,
“9 Trends That Will Shape Work in 2021 and Beyond,” Harvard Business Review, January 14, 2021, https://bit.ly/3dcrw96.
6. For example, see Amanda Barroso, “About Half of Americans Say Their Lives Will Remain Changed in Major Ways When the Pandemic Is
Over,” Pew Research Center, September 17, 2020, https://pewrsr.ch/3fmcksB.

118 The Appraisal Journal • Spring 2021

www.appraisalinstitute.org

Resource Center

Inflation Rates

Concern about the economy’s outlook for inflation arises largely from the widespread thought
that the COVID-related federal stimulus packages7 will be inflationary because of the massive
amounts of money8 put into the economy. Others
disagree, however, and believe the Federal
Reserve’s long-term 2% inflation target can and
will be achieved using Federal Reserve (Fed) and
US Treasury tools. The Fed has developed informational documents “in plain English” on how
monetary policy tools influence the economy
and inflation:
•	
“How Monetary Policy Works”
(https://bit.ly/3m3sUPA)
•	
“What Is the Fed: Monetary Policy”
(https://bit.ly/2PDplDz)
•	
“Monetary Policy Basics”
(https://bit.ly/3w7WJmI).9
The Dictionary of Real Estate Appraisal, sixth
edition, defines inflation as “an erosion of the purchasing power of currency characterized by price
escalation and an increase in the volume of
money, i.e., the proliferation of monetary units
and consequent decline in the value of each
unit.” 10 Many people remember the inflation of
the 1970s, when the US inflation rate was into
the teens. Mortgage interest rates between 1970
and 1981 increased from about 7.5% to 18% and
did not return to about 7.5% until after 2000.
Since 2000, mortgage interest rates have contin-

ued the decline and been under 5% for a decade.
That is why the mortgage rates of the last decade
have looked so attractive. Exhibit 1 illustrates
the inflation rate over a sixty-year period. As the
exhibit shows, the US inflation rate has been
under 5% for over three decades. By way of comparison, Exhibit 2 illustrates the mortgage rates
during periods of high and low inflation.
Inflation Impacts

Inflation is of importance to the real estate analyst and appraiser because inflation (price changes
over time) and expectations about inflation affect
the actions and decisions of real estate sector participants. Inflation impacts
•	buyer and seller confidence, thinking process, and motivations;
•	pricing (listings and offers);
•	strategies in planning and development;
•	investing motivations, calculation, analysis;
•	leasing and lease terms;
•	relocation decisions;
•	buy-hold-lease-sell judgments;
•	discounted cash flow forecasting incomes,
expense, and value change anticipations;
•	borrowing and lending decisions; and
•	considerations of investment risk.
In the aftermath of government measures
designed to offset economic damage during the
pandemic, many analysts, economists, and others are concerned about the likelihood of rising

7. The stimulus packages as of press time include the following: (1) the $2.2 trillion CARES Act (March 2020)—for details on the CARES Act,
see https://www.jpmorgan.com/insights/research/cares-act; (2) the $2.3 trillion Consolidated Appropriations Act (December 2020)—for
detail on this act, see https://bit.ly/3rCqgl2; (3) the $1.9 trillion American Rescue Plan (March 2021)—for detail on the Rescue Plan, see
https://bit.ly/2QDtkAi.
8. For readers interested in additional information on the cost of the COVID-19 packages, see “How Are We Paying for the Federal Response
to the Coronavirus?” Peter G. Peterson Foundation, February 5, 2021, https://bit.ly/2O1XqwB.
9. For additional information on the topic, see Kimberly Amadeo, “Monetary Policy Tools and How They Work,” The Balance (April 30,
2021), https://bit.ly/3syqElw; and Eric Petroff, “The Fed’s Tools for Influencing the Economy,” Investopedia, December 7, 2020,
https://bit.ly/3w7xgK1.
10. Appraisal Institute, The Dictionary of Real Estate Appraisal, 6th ed. (Chicago: Appraisal Institute, 2015), s.v. “inflation.”
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inflation. During an inflationary period, consumers will see a broad rise in price levels and a
fall in their purchasing power, i.e., a dollar effectively buys less than it did in prior periods.
The Consumer Price Index (CPI) is an impor
tant economic indicator, and the principal
measure of inflation (and deflation).11 Inflation as
measured by the consumer price index is the
annual percentage change in the cost to the average consumer of acquiring a basket of goods and
services.12 It examines the prices of consumer
goods and services, such as transportation, food,
and medical care, associated with the cost of living. A decline in purchasing power measured
using the average price level of the basket of
selected goods and services indicates inflation.13
The CPI is computed by the US Bureau of
Labor Statistics (BLS). The BLS’s CPI homepage,
https://www.bls.gov/cpi/, offers an overview of the
index, myriad CPI publications, online data,
explanations of the measurement methodology,
and interactive tools for computing inflation over
time.14 Some key CPI resources available from the
BLS include the following:
•	
Factsheets about CPI components
(https://www.bls.gov/cpi/factsheets/)
•	
CPI databases
(https://www.bls.gov/cpi/data.htm)
•	
Monthly CPI information
(https://www.bls.gov/news.release
/pdf/cpi.pdf)
•	
Producer Price Index information
(https://www.bls.gov/ppi/)

•	
CPI Handbook of Methods
(https://www.bls.gov/opub/hom/cpi
/home.htm)
•	
Core inflation modeling
(https://bit.ly/2Q84qJd )
•	
BLS publications
(https://www.bls.gov/opub/)
There are a number of BLS price indexes—
and thus databases—each made up of different
items. Therefore, it is important to specify which
index is being used in any analysis or benchmark. For real estate, the specific price index is
critical in contracts, leases, and other references.
The types of CPIs available include the CPI-U
(for all urban consumers), CPI-W (for urban
wage earners and clerical workers), CPI-E (for
the elderly), and C-CPI-U (chained CPI for all
urban consumers). Sometimes the core inflation
rate is the item of interest.
The core inflation rate is the price change of
goods and services minus food and energy,
because food and energy are relatively volatile
and might tend to distort the inflation rate. The
core inflation rate is also called the core “CPI for
All Urban Consumers Less Food and Energy,” or
the core “Personal Consumption Expenditures
(PCE) excluding Food and Energy.” 15
The most commonly used CPI is the “All
Urban Consumers (Current Series)”; this index
as well as others may be seen and accessed at
https://www.bls.gov/data/. Exhibit 3 shows the
CPI-U for all urban consumers, using 1982 as

11. See “Consumer Price Index (CPI),” Investopedia, https://bit.ly/2PGlyVK. For a very thorough explanation of the CPI see “The Consumer Price
Index,” chapter 17 in Handbook of Methods, Bureau of Labor Statistics, available at https://bit.ly/3wmf53x.
12. https://fred.stlouisfed.org/series/FPCPITOTLZGUSA.
13. See “What Is Inflation?” Investopedia, https://bit.ly/3lZUbCg.
14. Background information and a complete discussion of the index is also available from the BLS in its Handbook of Methods,
at https://bit.ly/3ue972r.
15. Kimberly Amadeo, “What Is the Core Inflation Rate?” The Balance, https://bit.ly/3dmPHlg. For a discussion of the effect of COVID-19 on price
inflation, see Matteao Luciani, “Quantifying the COVID-19 Effects on Core PCE Price Inflation,” February 25, 2021, https://bit.ly/3bpjIRs.
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Exhibit 1 US Inflation Rate, 1960–2019
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Source: https://fred.stlouisfed.org/series/FPCPITOTLZGUSA

Exhibit 2 30-Year Fixed Rate Mortgage Average
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Source: Freddie Mac, 30-Year Fixed Rate Mortgage Average in the United States [MORTGAGE30US], retrieved from FRED,
Federal Reserve Bank of St. Louis; https://fred.stlouisfed.org/series/MORTGAGE30US, May 14, 2021.
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the base year. The inflation rate is the change
in CPI from one time period to the next. For
example, the average annual inflation rate from
2000 to 2010 would be 2.73%, computed as
(219.2 – 172.2)/172.2 = 0.2729 = 27.3.
The concept of CPI is rather simple and
straightforward, but making calculations and
the effort to be consistent over time are more
complex. An outline and timeline of the
BLS’s efforts to adjust the CPI is available at
https://bit.ly/3eAwI8C. For example, the CPI
has some complications related to the “basket
of goods” data. The products’ features and attributes can change from one survey period to
another as well as change in quality and functionality. Pricing also is subject to variables.
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For example, “suggested retail prices” differ
from the actual sale price or discounted price,
which change over time. Also, price inflation
may be different for different categories of goods
and services. Exhibit 4 shows an example of such
price change variation in early 2021.
In addition to differences in inflation rates for
categories of goods and services, the inflation
rate may differ in different sectors of the economy; for example, over the past decade prices
and costs in the health care, education, construction, and housing sectors of the economy
have risen at a higher rate (i.e., had more inflation) than most other sectors. Similarly, as of
early 2021, sectors with prices outpacing general
inflation were housing, construction, food, and
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Percent Change from Year Ago, (% Chg.
from Yr. Ago*2)/% Chg. from Yr. Ago

Exhibit 5 Comparison Actual and 2% Target Inflation, 2010–2020
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Graph Source: FRED Economic Data, Federal Reserve Bank of St. Louis (November 9, 2020), https://fredblog.stlouisfed.org/?s=inflation

energy.16 As a result, it is important to consider
what each of the different price indices includes
or excludes from its economic components.17
The Federal Reserve has a 2% inflation rate
objective, as measured by the Personal Consumption Expenditures price index (https://
bit.ly/3bnZ2ZT). Its rationale for the 2%
number is that this target maximizes employ-

ment and price stability.18 However, in the past
decade the inflation rate has rarely achieved
the target rate (Exhibit 5).
There are many excellent resources available
online for better understanding of inflation—
the measures of inflation, the various inflation
indexes, the pros and cons of inflation, target
inflation rates, causes of inflation, levels of infla-

16. For an interactive chart and data on inflation without energy costs, see https://bit.ly/3rzKiML. Similarly, states and regions may have inflation
rates that are different from the nation rate, particularly in the short term.
17. For example, from February 2020 to February 2021, consumer prices for services less energy increased 1.3% with different rates of increase
for shelter, utilities, household, medical care, transportation, recreation, education and communication, and other professional services.
18. The target inflation rate is covered in the Federal Reserve document “Why Does the Federal Reserve Aim for Inflation of 2 Percent over
the Longer Run?” available at https://bit.ly/2PnkSFd.
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tion, policies aimed at controlling inflation,
deflation, and more.19 In the Appendix to this
Resource Center column, you will find links to
materials with information and insights on inflation and its role in the economy.
Inflation Outlook Post-Pandemic

Of course, no one knows what inflation will be in
the future, but some forecasting and assumptions
about the future are necessary for practically all
economic decision making. Real estate market
participants forecast in their decision making,
and so too must market analysts and valuers.20
This is perhaps most obvious in the income
approach when preparing operating statements,
discounted cash flows, and such, but consideration of the future, whether by projection or forecasting,21 permeates the valuation process.
The COVID-19 pandemic caused both wideranging economic and societal change. This
makes the job of forecasting more challenging,
both in the short term and longer term. Forecasts
currently posit that behavior changes will remain
long after the pandemic health crisis has passed
and impact future economic outcomes.22 There
are a number of wild cards in the post-COVID
economy. As previously mentioned, the final
total is unknown on how much the 2020–2021
stimulus programs will add to the national debt.
Also unknown is any impact the national debt
will have on real estate markets. For a fascinating
look at the changing national debt (total, per
citizen, per taxpayer, ratio to GDP, etc.), see

www.USdebtclock.org/. This dynamic website
shows federal spending, revenues, money creation, population, workforce, personal and
household income, and a lot more. At the bottom of the presentation are tabs for a mortgage
loan calculator and home sales data.
Recommendation. Although the economic out-

look is uncertain, significant information is available on trends expected to impact the real estate
sector. Analysts and valuers should take advantage of the many resources that are available to
help them address issues on the horizon.

Statistical Tools
Statistical analysis is a key element in the work
of market analysts and valuers. The following
discusses some useful and popular software to
enhance the analysis.
Excel Analysis ToolPak Add-in

Most real estate market analysts and valuers use
Excel software, the popular Microsoft spreadsheet program. The Excel add-in Analysis TookPak has a variety of helpful statistical tools
including the following:
•	ANOVA (single and two-factor)
•	Correlation
•	Covariance
•	Descriptive statistics
•	Exponential smoothing

19. For example, “Inflation,” by Jason Fernando, in Investopedia at https://bit.ly/30U0duH, has a good overview of causes of inflation,
demand-pull and cost-push, the idea of built-in inflation, types of price indexes, the formula for measuring inflation yourself, methods
of controlling inflation, negative interest rates, quantitative easing, hedging against inflation, and several other topics.
20. Forecasting requires valuers and others to estimate, calculate, or indicate in advance. Forecasts made by appraisers are based on past trends
and the perceptions of market participants concerning the trends’ continuation or alteration. For decision makers, market participants, and
analysts/valuers it makes no sense to ignore the anticipated future, i.e., expected consequences, costs, benefits, and such.
21. Generally, a projection is a mechanical extension of the past trends into the future; forecasting considers the past trends and adjusts for
current and likely future influences.
22. See J. Kozlowaki, L. Veldkamp, V. Venkateswaran, “Scarring Body and Mind: The Long-Term Belief-Scarring Effects of COVID-19,” Working
Paper, Federal Reserve Bank of St. Louis, April 2020, available at https://bit.ly/3loW37r.
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•	
F-test two-sample for variances
•	Fourier analysis
•	Histograms
•	Moving average
•	Random number generation
•	Rank and percentile
•	Regression (simple and multiple)
•	
t-tests (various)
• Z-test
To load Analysis ToolPak, visit Microsoft Support at https://bit.ly/3ro5rJO. However, Analysis
ToolPak is likely already part of your Excel program. An Analysis ToolPak guide is available on
the Microsoft website (https://bit.ly/31qE2ws).23
Guides are also available from third parties.24
Other Free Statistical Software
Available Online

There are a number of online resources to help you
identify free downloadable statistical software. An
internet search of “free software” results in listings
of relevant statistical software.25 These sites have
brief descriptions of SAS, Excel, SPSS, GraphPad
Prism, Minitab, MATLAB, as well as others.
One of the more comprehensive sites is
GoodFirm’s blog, “10 Best Free and Open Source
Statistical Analysis Software” (https://bit.ly
/3qYNMYX). This site provides a brief overview
of the four essential types of analyses performed
by statistical software: co-relational tests, regression tests, non-parametric tests, and comparison-

of-means tests. The site has brief descriptions of
these free statistical software packages, including
the types of statistical measures and tools provided. Here are the ten that are listed:26
1. JASP (https://jasp-stats.org/)
2.	SOFA (https://bit.ly/3tzuyei; uses Python
language)
3. G
 NU PSPP (https://bit.ly/2Q7FFwU)
4.	SCI Labs (https://www.scilab.org/)
5.	Jamovi (https://www.jamovi.org/; built on
R language)
6.	MacAnova

(http://www.stat.umn.edu/macanova/)

7.	PAST (https://bit.ly/2Qkbu5n)
8.	Develve (https://develve.net/)
9.	InVivoStat (https://invivostat.co.uk/;

combines complex and powerful statistical
tools within R with a user interface that is
both easy to use and intuitive to the
non-statistician)

10.	IBM SPSS

(https://www.ibm.com/analytics/spss-trials)

These free statistical programs are some of the
most popular, but others may be available, particularly for certain corporate employees or students
and faculty. In addition, there are other statistics
programs available that are not free but have a
free trial period or online demo.
Valuers interested in for-purchase statistical
software may want to visit the Capterra website
(https://bit.ly/3tEDAqr). This website includes a

23. To activate this Excel add-in, open Excel, go to File > Options > Add-ins > Analysis ToolPak. Analysis Toolpak is then available under the
Data tab and has an icon labeled “Data Analysis” in the Analysis portion of the ribbon. Note this “Analysis ToolPak” icon is not the same
as the “Analyze Data” icon in the Analysis section of the ribbon under the Home tab. The Analyze Data icon under the Home tab presents
ideas for graphs of a dataset you have highlighted.
24. For example, see Add-Ins.com, https://www.add-ins.com/Analysis_ToolPak.htm; Better Solutions, https://bit.ly/3rzxlmn; Excel Easy,
https://bit.ly/2PbWhmF; SpreadSheeto, https://spreadsheeto.com/analysis-toolpak/; and Universal Class, https://bit.ly/31nulyv.
25. For example, see “Top 8 Free Statistics Software of 2020,” https://bit.ly/3vXzQ4y; “Top 20 Free Statistical Software (Statistics and Data
Analysis),” https://bit.ly/2Q6AgWX; and “Free Statistical Analysis Software,” https://bit.ly/3vUUeTQ.
26. As noted, some of these programs use the R language in their software. For overview information about R as well as manuals, see
“The R Project for Statistical Computing,” https://www.r-project.org/.
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helpful Buyer’s Guide addressing key considerations in purchases of statistical software and lets
you customize the product search based on your
business size and needs. There is also a descriptive
comparison and checklist of business statistical
programs available for purchase or licensing.
Among the programs described are the following:
• Tableau (https://tabsoft.co/2Qjnggm)
• OriginPro (https://bit.ly/2P7EjS1)
•	
SPC for Excel (https://bit.ly/3c1D0wE)
•	
Statgraphics Centurion
(https://bit.ly/2QnLwhv)
• SigmaXL (https://bit.ly/3lrZKJB)
• Intellectus Statistics (https://bit.ly/3cOGstJ)
•	
Neuton AutoML (https://bit.ly/3cKI1Jf)

• Minitab (https://bit.ly/310cihC)
•	
MPP BI (https://bit.ly/3vHl2ra)
•	
SAS/STAT (https://bit.ly/2NuZLjg)
The Capterra website also includes a helpful comparison table, noting key features and ratings of
each statistical program (https://bit.ly/3cKCSRE).
Recommendation. If you use extensive statistical

analysis in your work or plan to, a first step is to
become familiar with the Excel Analysis ToolPak
add-in. Then, if you need more extensive statistical capabilities, investigate the statistical software options noted, taking into consideration
their ease of use and features.
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Appendix Additional Reading on Inflation and Economy
Inflation, Prices, and the Economy
•	
“Data: Prices and Inflation,” Bureau of Economic Analysis, https://www.bea.gov/data/prices-inflation,
customizable time series data, tables, and calculators by subject.
•	
“Indicators,” https://tradingeconomics.com/indicators, and “Inflation,” https://bit.ly/3srmnjX, Trading
Economics, current economic indicators in the United States and international.
•	
“Prices and Inflation,” Bureau of Economic Analysis, https://bit.ly/3fhmZTM, explains different types of price
indices. The Bureau’s website also has a variety of other economic information.

Inflation Targeting/Target Rates
•	
“Does the National Debt Matter?” David Andolfatto,” Federal Reserve Bank of St. Louis, https://bit.ly/3ftY15p;
see section on inflation targeting.
•	
“The Fed’s Inflation Target: Why 2 Percent?” Kristie Engemann, Open Vault (Federal Reserve blog),
January 16, 2019, https://bit.ly/FEDtarget.
•	
“How Inflation Targeting Works,” Kimberly Amadeo, The Balance, November 30, 2020,
https://bit.ly/3xwCPSj, explains targeting and its mechanics.
•	
“What Is Inflation and How Does the Federal Reserve Evaluate Changes in the Rate of Inflation?”
https://bit.ly/3ho9AfA, Board of Governors of the Federal Reserve, September 9, 2016.

Housing Markets
•	
“America’s Housing Market Is Officially Overheating Everywhere. How Long Will It Last?” Peter
Lane Taylor, https://bit.ly/3fi4jUb.
•	
“Economists’ Outlook: Home Prices: A Closer Look at Local Trends,” Nadia Evangelou, National Association
of Realtors, January 13, 2021, https://bit.ly/3cxJdkx.
•	
“Housing Supply: A Growing Deficit,” Freddie Mac Research Note, May 7, 2021, https://bit.ly/2RVxZyp.
•	
“Investors and Housing Affordability,” Carlos Garriga, Pedro Gete, and Athena Tsouderou, Working Paper,
Federal Reserve Bank of St. Louis, July 2020, https://bit.ly/3loVM4p. Study of how investors affect rents and
prices.
•	
“US Home Sales Are Surging. When Does the Music Stop?” Stefanos Chen, April 22, 2021,
https://nyti.ms/3booHSs.
•	
“Will the US Housing Market Boom Continue in 2021?” J. P. Morgan. December 2, 2020,
https://bit.ly/3wcXtH8.

National Debt
•	
“Charting America’s Debt: $27 Trillion and Counting,” Visual Capitalist, https://bit.ly/3fqebg4. A vivid
presentation on elements of national debt.
•	
“Does the National Debt Matter?” Regional Economist series, Federal Reserve Bank of St. Louis, December
2020, https://bit.ly/2PDnqyK.
•	
“Federal Debt: Total Public Debt” (interactive chart), Federal Reserve Bank of St Louis,
https://fred.stlouisfed.org/series/GFDEBTN.
•	
“How Much Money Did the Federal Government Collect and Spend in 2020?” Bureau of the Fiscal
Service, US Department of Treasury, https://bit.ly/3bl5aC3.
CONTINUED >
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Appendix (continued )
•	
“Making Sense of the National Debt,” Scott A. Wolla and Kaitlyn Frerking, Page One Economics,
Federal Reserve Bank of St. Louis, https://bit.ly/38SoAwZ.
•	
“National Debt of the United States,” Wikipedia, https://bit.ly/3bXnOkl. Consolidates information
from variety of sources, summarizes issues on national debt, and presents data in helpful graphs.

Projections/Outlook
•	
“Creating Valuations Amid Uncertainty,” Michael Polon, CIRE, Fall 2020, https://bit.ly/3sJgC0Y.
•	
“Instant Reaction: Inflation,” National Association of Realtors, January 13, 2021,
https://bit.ly/39naO5W.
•	
“5-Year, 5-Year Forward Inflation Expectation Rate” (daily), Federal Reserve Bank of St. Louis,
https://fred.stlouisfed.org/series/T5YIFR.
•	
“How Well Do Consumers Forecast Inflation?” Federal Reserve Bank of St. Louis, March 23, 2021,
https://bit.ly/3lZNIY0.
•	
“Inflation Is Coming for Your Wealth. Here’s What Investors Can Do,” Forbes, February 26, 2021,
https://bit.ly/3cvDLOR.
•	
“Outlook 2021: Why the Era of Low Inflation Could Last for 50 Years,” Meghnad Desai, Office
of Monetary and Financial Institutions Forum, January 14, 2021, https://bit.ly/2PhZ1Pt.
•	
“An Overview of the Economic Outlook: 2021 to 2031,” Congressional Budget Office, February 1, 2021,
https://www.cbo.gov/publication/56965.
•	
“Projected Annual Inflation Rate in the United States from 2010 to 2026,” Statista, April 14, 2021,
https://bit.ly/3futvZ0.
•	
“Short-Term and Long-Term Inflation Forecasts: Survey of Professional Forecasters” (quarterly),
Federal Reserve Bank of Philadelphia, https://bit.ly/3cvvkDn.
•	
“University of Michigan: Inflation Expectation,” survey of consumers (monthly), Federal Reserve Bank
of St. Louis, https://fred.stlouisfed.org/series/MICH.
•	
“US Inflation Outlook: Don’t Believe the Hype,” Joseph Brusuelas, The Real Economy (blog),
March 3, 2021, https://bit.ly/3sDZ7iD. Website also includes data by market sector, including “Real Estate,”
https://bit.ly/2RM8kYW.
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